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Please follow these guidelines when you first submit your article for consideration by the 
journal editors and when you prepare the final version of your article following acceptance 
for publication.

General Points

The Journal for Cognitive Historiography (JCH) considers original submissions from 
researchers in the Humanities as well as Social and Medical Sciences, especially if working on 
cross-disciplinary enterprises. Articles should be written for a general scholarly audience. All 
articles are peer/blind reviewed. Each issue of the journal includes articles, short research 
reports, commentaries, and book reviews. The journal is published in print and online, and 
online publication of an article generally precedes print. The editor will not consider 
manuscripts that are under consideration by other publishers or that have been published 
elsewhere. It is assumed that once submitted to JCH articles will not be sent to other 
publishers until a decision about inclusion has been reached.

Subject Matter

Cognitive Historiography is a burgeoning field at the centre of cross-disciplinary research. 
Cognition describes the various workings of brain/mind; cognitive historiography explores the
ways those workings may have shaped historical remains and historiographical constructions.

JCH seeks to publish the widest possible diversity of critical inquiry into the relationship 
between cognition and “pre-history,” archaeology, and history. It welcomes contributions 
covering all periods, regions, and topics of historical and archaeological study, and raising 
methodological or theoretical questions. Cognitive approaches may include but are not 
limited to those found in the disciplines of cognitive psychology,  anthropology, sociology and
neuroscience, medical humanities as well as evolutionary theorising. The journal does not 
subscribe to any programmatic concept of brain or mind and is open to publishing work by 
scholars interested in sensorial, emotional, and experiential histories. Given the 
interdisciplinary aims of the journal, authors should not assume that readers share their own,
specialised, disciplinary backgrounds. Specialised jargon should be eliminated or explained 
when first used.

Articles

Articles are to be a maximum of 6,000 words in length, should be accompanied by a 
bibliography and may be accompanied by notes (see below). The bibliography does not count
towards the word limit, however, the notes do.

Research Reports should be a maximum of 4,000 words. Short Reports should be a maximum
of 2,500 words.
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Commentaries, Addenda and Book Reviews

Always check with the Book Review editor before submitting a review in case the book you 
are interested in reviewing has already been assigned. Book reviews are to be 400– 1,400 
words in length and reviewers should refrain from the use of notes and references as much 
as possible.

Language of Publication

The language of publication is English. The language of submission should be Oxford English 
(for example: randomize not randomise]. 

Review Process

All submissions are evaluated through a double-blind review process, and may include review
both by editorial board members and external reviewers. The editor will make every effort to 
have all submissions evaluated in a timely manner. You will be able to track the progress of 
your submission through this system when you log in as an author.

Articles may be accepted or refused, or authors may be asked to make changes and then 
resubmit. The possibility of an author rebuttal exists.

Permissions

Authors are expected to clear copyright for any copyrighted material they use or quote, 
including artwork.

Online Submissions

Please submit your article through our website. If this is impossible, please contact the 
Editorial team for assistance.

Online submission is a five-stage process.

Once you have begun the process, you will be prompted to supply various types of 
information (metadata), as well as your article. These include: a 150 word abstract (book 
reviews do not require abstracts); three to five keywords; a short biographical statement; 
contact details; and appropriate Library of Congress subject classification codes, among other
things. This metadata is important because it facilitates the indexing of your article once it is 
published, leading to more citations and greater readership.

You will be asked to upload your article. Your submission should be in Microsoft Word. If 
using another word processor, convert the final file into Rich Text Format (RTF). Manuscripts 
should be formatted using one and a half line spacing, printed and numbered consecutively
throughout.
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PDFs are not acceptable for submission of articles. However; you can upload a PDF through 
the system as a supplementary file following submission of the Word file if you wish to bring 
to the attention of the editor any particular features that will be required at the layout stage 
or to clarify font usage. It is advisable to upload a supplementary PDF file if your submission 
includes non-Latin characters. There is a separate step in the process for this, or to upload 
any other supplementary material such as (a) research instruments (b) data sets (c) sources 
that would otherwise be unavailable to readers or (d) audio/video material. If you intend 
these to become an official part of your final article, please indicate in a note to the editor(s). 
Some material may be suitable only for the electronic version of the journal.

Ensuring a Blind Peer Review

All articles are peer-reviewed. To ensure the integrity of the blind peer review we need to 
make every effort to preserve the anonymity of authors and reviewers. Therefore when 
preparing your article for submission please take the following steps:

1. Remove your name entirely from the text. If you cite your own publications be sure to 
substitute the word ‘author’ for your own personal details and for the actual title of the work 
cited.

2. With Microsoft Office documents, author identification should also be removed from the 
properties for the file (see under File in Word), by clicking on the following, beginning with 
File on the main menu of the Microsoft application: File>Save As>Tools >Security>Remove 
personal information from the file properties on save>Save [or on Microsoft for Mac: 
Review>Protect>Protect Document>Privacy> tick Remove personal information from this file 
on save ].

3. On any PDF uploaded, remove the author names from Document Properties found under 
File on Adobe.

Journal Style Guidelines

It is essential that the following guidelines are observed. We may ask you to revise your 
article if it is not supplied in house style.

1. Manuscripts should be formatted using Times New Roman size 12, one and a half (1.5) 
spacing, and pages numbered consecutively throughout. Margins of approximately one and a
half inches or 39mm should be used.

2. Quoted matter, if more than four lines, should normally be indented, without quotation 
marks.

3. Quotations of up to four lines should form part of the text, and should be indicated by 
double quotation marks. single quotation marks should be used only for quotations within 
quotations.
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4. In general, foreign words and phrases should be italicised, both in main text and footnotes.
Words in non-Latin languages and scripts should be transliterated, and a translation supplied.

5. Oxford English -ize spellings should be used (recognize, emphasize, organization, etc. BUT 
analyse, exercise, etc.).

6. Contributors from North America may use North American spelling and punctuation.

7. Headings: Please mark-up heading levels 1.1, 1.2, 1.2.1 etc. These will be removed later, 
but are helpful to the typesetter to assign heading styles.

8. For dates, please use BCE (before common era) and CE (common era). Note that you need 
not use ‘CE’ if this is understood in the text.

9. Full dates should be given in the order of day, month, year, without punctuation. Example: 
5 March 2003.

10. Where a gender-inclusive alternative is possible, it is preferred (e.g., ‘humanity’ rather 
than ‘man;’or a gender-neutral pronoun for the individuals who are being discussed and 
whose gender is unknown, unclear, or variable).

References 

Every work quoted from or mentioned in the text must be included in the references section.
The references section should be located immediately after the body of the article. Please 
double-check to be certain that all dates given in parenthetical citations and in the references
section are identical.

1. The JCH employs The Chicago Manual of Style, 16th Edition. Works should be cited in the 
text by the author/date system: that is, give the author’s surname and year of publication. If 
the citation refers to a direct quote, page numbers should be specified, e.g. (Jones 1998, 64). 
Multiple references are separated by a semicolon (e.g. Jones 1998; Ernaux 2016).

2. Bibliographic references should conform to the following order: author surname and first 
name, title, place of publication, name of publisher, date of publication.

For specifics in regard to referencing and biblographic style (in text, notes, and works cited), 
please see: https://www.chicagomanualofstyle.org/tools_citationguide/citation-guide-2.html

Please ensure that the bibliographical references are consistent.

3. Reference and bibliographical lists should always be arranged in alphabetical order by 
author. Where there are two or more works by the same author in the same year, they 
should be distinguished as 1997a, 1997b, etc. Works should be listed from earliest to most 
recent date of publication.

4. References to primary sources must not be abbreviated at any time.
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If only one text of any given author is referred to, use either the author’s name or the title of 
the work referred to, but both author and text must be spelled out in a separate list of 
primary sources that precedes the list of secondary sources. If more than one text by one and
the same author is referred to, then a short title must be used in the in text reference – but 
never an acronym (e.g. Annals or Aeneid rather than Tac. Ann. or Verg. Aen.)

Use Arabic numerals only in references to specific text passages, separated by a full stop 
without space (e.g. 3.2.12-14)

In the list of primary sources, use English versions of the author’s name and title of the text if 
these are commonly used.

5. Please make an effort to diversify and decolonise the list of secondary literature to 
guarantee an inclusive process of knowledge production.

Figures and Artwork

Figures should be provided as separate, high-resolution files. Every Figure must have a brief 
caption, correspondingly numbered, which will be printed beneath the figure: do not include 
the caption on the actual Figure. Cite all illustrations as Figures (not plate, map, plan, 
illustration, etc.).

Indicate in the text where each Figure (or Table) should appear, by writing on a separate line 
‘Insert Figure xx about here’ at the appropriate point. Figures and Tables should be 
numbered in the order of their first appearance in the text.

Below each Figure caption, please also include a brief alternative description of the image (alt
text). This is essential for the accessibility of your published paper. The alt text should be no 
more than 125 characters in length, and should describe, succinctly, what information is 
conveyed by the image, if that information is not already provided by the caption. Please do 
not repeat the caption, or start the alt text with 'Image of'. For  example, the following Figure 
has the caption 'Suwa, a traditional Ethiopian beer essential to social gatherings'. Appropriate
alt text could be: 'A plastic cup, filled with a dark-brown liquid, is being held by a person 
standing outside a house, in a group.' The alt text will be coded into your paper, and is 
intended to be read out by a screen-reader. It will not be visible on the final proof.
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Tables

1. All tables are left in place in the ms.

2. Table captions are inserted before the table. 

3. Tables do not contain tints in cells.

Open Access

Please find information about Equinox Publishing policies on Open Access/Archiving at this 
link: https://journal.equinoxpub.com/JCH/Open

Statement on Ethics

Please read the Equinox Publishing statement on Publication Ethics and Malpractice: 
https://journal.equinoxpub.com/JCH/Ethics.

The editors acknowledge systemic issues around violence, racism, discrimination, and 
epistemic injustice, and they feel the responsibility to support vulnerable individuals as well 
as help changing academic standards. They take seriously allegations of misconduct in the 
workplace. They believe in empowering victims who voiced their allegations and shared their 
experience of trauma or bullying. The JCH is a survivor-centred research environment that 
honours victims of violence, assault, and abuse. While we recognise that this is not always 
possible, we encourage authors to boycott and avoid citing the research of scholars who, for 
example, have been found guilty of sexual harassment charges. The editors believe that a 
way to promote justice and safety for all in the academia is ignoring the work produced by 
scholars whose behaviour raise ethical concerns.

Kindness, politeness, and civility will be appreciated as essential in any form of written or oral
communication between the editors, the team at Equinox, and the contributors.

Instances of academic bullying at any stage of the publication process will be promptly 
addressed.

The editors strive to create collaborations that foster mentally healthy interactions. 
Reviewers participating in the blind peer review procedure as well as those writing a book 
review are expected to offer constructive and respectful feedback. Reviewers are asked to be
aware of their unconscious biases. They are invited to evaluate the scholarship rather than 
the person and their disciplinary backgrounds. Ad personam attacks and malevolent 
comments will not be taken into consideration.

In case of rejection of submissions to the journal, the editors will try to explain with clarity 
and care the reasons behind their decision, and the same research can become worthy of 
publication on another occasion or venue.
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AI-generated Content

Equinox does not accept text, images, graphics or translations generated by Artificial 
Intelligence, or by AI-powered tools, as the originality of such content cannot be guaranteed. 
Authors of Equinox publications must be accountable for their work, and accountability 
cannot be effectively applied to Artificial Intelligence at this stage. If Artificial Intelligence is 
the subject of a paper, then examples of AI-generated content must be clearly marked and 
attributed in the text, and the express permission of the editors secured.

Preprint Manuscripts

Equinox does not accept manuscripts that have already been submitted to preprint 
repositories, such as SSRN. However, an author may deposit their accepted postprint 
manuscript in their Institutional Repository (only), with due acknowledgement to Equinox 
Publishing and an embargo period of 24 months. Please see 
https://www.equinoxpub.com/home/open-access-policy/ for more information.

---
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